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1 Introduction

Since this software is not intended to offend any sensibilities, the termMainDevice (abbreviatedMainDevice) replaces
“master” and SubordinateDevice (abbreviated SubDevice) replaces “slave”.

1.1 Overview

EC-Inspector is a diagnosis tool for EtherCAT networks that are controlled by any EtherCAT MainDevice (EC-
Master, TwinCAT, CoDeSys 3.5.17. and higher, …) with help of the EC-Monitor.
The user needs an ENI file to start the EC-Monitor. The EC-Monitor will collect the data from the EtherCAT
network.
The EtherCAT network does not have to be changed. Only a TAP or switch is needed to collect the data.

1.2 Requirements

• Microsoft Windows 10 and above
• Microsoft .NET Framework 4 Client Profile
• Screen resolution at least 1024x768 pixel
• Memory as recommended for operating system
• Disk space approximately 80 MB (depend on number of ESI files)
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2 Installation

2.1 Setup Process

The EC-Inspector can be installed by executing the setup.exe (requires administrator privileges) and follow the
screen instructions:
Welcome page:

License Agreement:
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Select Installation Folder:

Confirm Installation:
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Installing:

Installation Complete:
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2.2 Silent Installation (optional)

The EC-Inspector can be also installed in silent mode by using the command line parameters of msiexec.
Sample 1: Installs EC-Inspector into default installation folder
PS C:

> msiexec /i c:/temp/EcInspectorSetup.msi /quiet /qn /norestart /log
c:/temp/install.log↪→

Sample 2: Installs EC-Inspector into “C:/EC-Inspector”
PS C:

> msiexec /i c:/temp/EcInspectorSetup.msi /quiet /qn /norestart /log
c:/temp/install.log INSTALLLOCATION="C:/EC-Inspector"↪→

For more information please refer command line parameters of msiexec.

Note: The system requirements (see section “1.3”) will be not checked!
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2.3 File and Folder Structure

The setup process will copy all necessary files into the following folder:
Installation directory:

/Doc
Release notes and the user manual

/EEC
Files for mapping emergency error codes

/Languages
Lanugage specific files

/

• EC-Inspector.exe
• EcWrapper.dll
• …

All users directory: ( %ALLUSERSPROFILE%/EC-Inspector, like C:/ProgramData/EC-Inspector)

/CAPTURE
Capture files which can be analysed in offline diagnosis mode (see Capture File)

/EMI
EtherCAT MainDevice Information files

/EtherCAT
EtherCAT SubDevice Information (ESI) Files. Can be modified via ESI-Manager

/

• ESICache.xml (ESI-File-Cache for faster access of ESI files)

– EC-Inspector.log (Log File)
– User.myusername.xml (User specific settings)

2.4 NDIS Driver

The Network Driver Interface Specification (NDIS) is the specification for a network driver architecture that allows
transport protocols like TCP/IP to communicate with an underlying physical network adapter. For sending and
receiving EtherCAT frames inWindows, EC-Inspector makes use of the well-knownWindows packet capture library,
WinPcap. However, WinPcap was based on the NDIS 5.x driver model, and development has ceased. The latest
versions of Windows 10 do not support this old NDIS 5.x version anymore, so now EC-Inspector (V3.2 and higher)
includes an installation package in the install directory of EC-Inspector to install the acontis NDIS 6.x Filter Module
EcatNdis.sys. With this new Filter Module and the new NDIS Link Layer emllNdis.dll, it is now possible
for EC-Inspector to work without WinPcap on all Windows 10 versions.

Note: Please restart EC-Inspector after the NDIS installation.
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3 Graphical user interface

3.1 Overview

This section gives an overview about the graphical user interface:

The graphical user interface is divided into five parts:

Menu/Tool/Status bar:
Shows current status or mode of the EC-Inspector and allows the user to change it.

Project Explorer:
Shows different views of the current network configuration

Device Editor:
Show information about the selected device, like process variables.

Short Info:
Show short information about selected device, like name, description or vendor.

Messages:
Shows notifications which occur e.g. when the EtherCAT Device has changed its operation state or a
SubDevice has been removed from (or added to) the EtherCAT network.
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3.2 Menu/Tool/Status bar

3.2.1 File

New / Open / Save / Save As / Print:
Start new configuration or open/save/print existing configuration

ESI-Manager:
Add, delete or export ESI and SCI files (see: ESI-Manager)

Recent Projects:
Open recent project

Exit:
Closes the EC-Inspector

3.2.2 View

Message Window:
Shows/Hides the message window

Short-Info Window:
Shows/Hides the short-info window

Refresh:
Updates the current view

3.2.3 Network

Inspection Report (active only in diagnosis mode):
Opens a statistic about the state of the network. Collects some useful data like error counters and so on.
Possibility to print a PDF. See Inspection Report

Hardware Diagnostics:
Enables or disables the additional hardware diagnosistics and warnings in project explorer.

Acknowledge all warnings (active only in diagnosis mode):
Clears the yellow warning icon of all SubDevices

Take Snapshot:
Takes a snapshot from the current diagnosis state and saves it into a capture file (for more information about
the snapshots and capture files, see Capture File)

Automatic Snapshot Mode:
Activates the automatic snapshot mode to take snapshots based on the configured rules

Snapshot:
Changes the active snapshot
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3.2.4 Settings

Message Level:
Change the current message level

Settings:
Shows more settings in the dialog Settings

3.2.5 Help

Show User Manual:
Shows this user manual

Show Log File:
Shows the log file

Check for updates:
Enable / disable automatic update check (once per month). Also a manual update check is performed on
activation.

About …:
Show the about dialog

3.3 Project Explorer

3.3.1 Drag and Drop

It is possible to drag and drop files here to import/open them
Project file

Opens the configuration stored in the ECC, only one project file can be imported at a time.
ESI files

Adds the files to the ESI-Manager, it only allows ESI, SCI and ZIP files, multiple files are allowed.
The context menu of one or more selected SubDevices has the following entries:

Enable SubDevices:
Enable disabled slaves

Disable SubDevices:
Disabled slaves will be ignored by EC-Monitor if they could not be seen by TAP

3.3.2 Configuration Mode

There are three topology visualisation views:
Classic View
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This is a tree view with multiple levels.
Flat View
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This view shows all SubDevices in a flat list, as they are connected in the EtherCAT network.
Topology View

This view shows a graphical tree of all SubDevices, as they are connected in the EtherCAT network.

3.3.3 Diagnosis Mode

There are three topology visualisation views:
Classic View
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This is a tree view with multiple levels.
Possible device states:

Init Bootstrap

Pre-Op

Safe-Op

Op
Flat View
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This view shows all SubDevices in a flat list, as they are connected in the EtherCAT network.
Possible device states:

Init Bootstrap

Pre-Op

Safe-Op

Op
Topology View
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This view shows a graphical tree of all SubDevices, as they are connected in the EtherCAT network.
Possible device states:

Init Bootstrap

Pre-Op

Safe-Op

Op
Possible port states:

Bad Cable Quality

Constricted Cable Quality

Good Cable Quality
If cable quality is constricted or bad, please check the error counters of the SubDevice (for more information
about the extended diagnosis, see Extended Diagnosis).
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3.4 Device Editor

This Editor gives the user the possibility to read and write information of the selected device or SubDevice:

3.5 Short Info

This window shows short information about selected device, like name, description or vendor:
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3.6 Message Window

Shows notifications which occur e.g. when the EtherCAT MainDevice has changed its operation state or a
SubDevice has been removed from (or added to) the EtherCAT network:

There is also a SDO Message Window, where only mailbox messages are shown. For example CoE messages and
FoE messages. With EC-Inspector it is also possible to save the FoE file which is transferred on the network to a
specific folder.
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4 Configuration Mode

4.1 Overview

At startup of EC-Inspector, the user will see this page:

4.2 Device Settings

4.2.1 General

In this tab, the user can configure the cycle time. If he wants to connect to a control system, this can also be
configured. After one of thesemodes is selected, the ENI file will be imported to show the configuration:
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General

TAP Type:
Select the type of TAP adapter which is used. Generic is for a standard switch. Supported is also the
ET2000. More will be supported in the future.

ENI File:
Path to the ENI which is used in the network that should be monitored. The ENI file can be exported in
EC-Inspector. More Infos about the ENI file from Third Party MainDevices can be found here Operating
with Third Party EtherCAT Controller

Mode 1: Online analysis via TAP connected to local system

LinkLayer:
Select the Link-Layer which should be used.

Network Adapter:
Network adapter which is connected to TAP or the switch.

Mode 2: Offline analysis of EtherCAT frames captured by Wireshark
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Capture File:
Path to the capture file pcap

Read multiple files:
Select if wireshark is captured in more files

For more information about the capture files, seeWireshark File
Mode 3: Load EC-Inspector snapshot

Capture File:
Path to the capture file, which contains one or more snapshots ecd

For more information about the snapshots and capture files, see Capture File

4.2.2 Process Data Image

In this tab, the user can see all variables of the process data image. It can also be exported.

If the variables should be exported, the following dialog appears:

Export Formats:

• CSV File (Semicolon separated text file)
• CSV PLC File (Semicolon separated text file, where offsets are in PLC format)
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• PD Layout File (C-Header file which can be used from EC-Master-Demo application)
• XML File (Like ProcessImage in ENI)

The variables can also be added to the watchlist, to have a better overview in diagnosis mode.

4.2.3 Watchlist

In this tab, the user can see all variables which were added to the watchlist in config mode:

The variables can be edited and removed from the watchlist.

4.2.4 Data Acquisition

In this tab, the user can configure our Data Acquisition (DAQ) library. This library can be used from EC-Master to
record process data in realtime.
After adding a new recorder, the user can select the variables which should be recorded and specify some

triggers:
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Variables:

Add/Remove:
Used for adding or removing the selected variable to the recording.

Triggers:

New/Edit/Delete:
Used for changing the trigger list.

If user wants to edit a recorder, he will see the following dialog:

acontis technologies GmbH AT3219 Page 26/81



User Manual

Name:
Name of the recorder

File:
Absolute path of the recorder file on the MainDevice system

Format:

Format of the recorder file, e.g.

• MDF (Measurement Data Format)
• CSV (Comma Separated Values)

Sample Rate:
Sample rate of the recorded data e.g. every cycle or every second cycle, …

Real time stamp:
Adds a real time stamp to the recorded data

Cycle counter:
Adds a cycle counter to the recorded data

If user wants to edit a trigger, he will see the following dialog:
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General

Left variable:
Name of the left variable

Operator:
Operator of the trigger (e.g. =, >, >=, <, <=, !=)

Right value:
Value of the right operand to compare the left variable against a static value e.g. trigger, if variable
is greater than 5

Right variable:
Name of the right variable to compare the left variable against the value of another variable e.g.
trigger, if variable 1 is smaller than variable 2

Enable:
Enabled or disabled trigger (can be enabled from application later)

Start:
Start or stop trigger

Optional

Duration:
Duration in ms (0 = infinite) e.g. trigger should start recording for 500 ms

Count:
Trigger count (0 = infinite) e.g. trigger should hit only for 5 times

For more information please refer the manual of the EC-Master-Data-Acquisition-Library.
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4.2.5 Trigger

In this tab, the user can create, edit und delete trigger. When a trigger is hit, the monitor will stop and show
the actual state. Trigger can be created for process data and notifications. To switch to the notification
trigger select the tab in top right corner. This tab is also shown in the diagnosis mode to enable and
disable trigger while in diagnosis mode.

Trigger:
List of trigger.

Edit Trigger:

New: When new is clicked the following dialog pops up:
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The user can select variable which should be compared and the select if he wants to compare with a
value or another variable. With enable the trigger can be enababled and disabled.
The following dialog pops up on the notification trigger tab:

The user can select which notification should be triggered. He can also select for which SubDevice
the notification should be triggered. Default is “All SubDevices”. It is also possible to trigger all
notifications for all SubDevices.

Edit: Edit the selected trigger
Delete: Remove the selected trigger from project
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If the EC-Inspector stops because of a trigger it can be restarted with Run. It is also possible to pause the
EC-Inspector without a trigger:

4.3 SubDevice Settings

4.3.1 General (SubDevice)

In this tab, the user can see general SubDevice settings like station address or the name of the SubDevice.
Also the connected ports can be seen.

Address

Station Address:
Station address of the SubDevice. By default, the first station address is 1001.

Information

Name:
Name of the SubDevice. By default the following format is used “SubDevice_N [TYPE]”

Description:
Description of the SubDevice (Read from ESI file)
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Vendor:
Name of the vendor the SubDevice

Product Code:
Product Code of the SubDevice

Revision Number:
Revision Number of the SubDevice

ESI File:
Name of the ESI `file where the description of the SubDevice is stored.
:file:`ESI files can be managed by using the ESI-Manager

Identification Value:
Identification Value of the SubDevice

Ports

Connected Devices:
List of connected devices

4.3.2 Variables

In this tab, the user can see the variables of the SubDevice.

Lists of Variables
Variables comes from the import of the ENI file.

Buttons

Add to watchlist:
Adds the variable into the watchlist
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5 Diagnosis

5.1 Overview

EC-Inspector is a diagnosis application specifically developed to analyze EtherCAT networks that are controlled by
an EtherCAT MainDevice. Automated control systems usually require high availability of the whole system. Due to
the rough industrial environment this is often hardly to achieve.
If high availability shall be guaranteed for an automated control system it is important to verify and maintain the field
bus. Using EC-Inspector it is possible to take a look into the “health” of the EtherCAT system. Detection of signs of
system degradation prior to running into a system failure will be of great benefit. In that case it is possible to exchange
the problematic components (cables, SubDevice devices).
Many aspects of diagnosis are covered by the EC-Inspector:

• System analysis and maintenance
• Error detection
• Documentation

After switching into diagnosis mode of EC-Inspector, the user will see this page:
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5.2 Device

This section shows the current “health” state of the MainDevice and helps the user to analyze MainDevice related
problems.

5.2.1 General

In this tab, the user can see the current state of the state machine of the MainDevice. He has also an overview over
the current “health” state of his EtherCAT network:

State Machine

Current State:
Current state of the MainDevice

Requested State:
Requested state of the MainDevice

Information

Device version:
Version number of the running MainDevice

Number of found SubDevices:
Number of SubDevices, which were found from device on the network

Number of SubDevices in configuration:
Number of SubDevices, which are configured in the ENI file

Number of DC SubDevices:
Number of SubDevices with DC support, which were found from MainDevice on the network
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DC in-sync:
Signals that all SubDevices with DC support are correctly synchronized or not. If not all SubDevices are
correctly synchronized, please refer the Message Window for more information.

Topology OK:
Signals that topology is “okay” or not. If topology is not “okay”, you have a mismatch between the
configured bus and the currently connected bus. Please open the ‘Network Mismatch Analyzer’ (Menu
Network Network Mismatch Analyzer) to solve the problem.

Link Connected:
Signals the link is connected.

SubDevices in MainDevice State:
Signals that all SubDevices are in MainDevice state.

Frame Counter

TX frames:
Number of sent frames

RX frames:
Number of received frames

Lost frames:
Number of lost frames

Cyclic frames:
Number of cyclic frames

Acyclic frames:
Number of acyclic frames

Memory Usage

Current:
Current memory usage in bytes

Max:
Maximum memory usage in bytes

5.2.2 Process Data Image

In this tab, the user can see and change the values of the process variables. The variables will be forced to the value
the user entered. The user can press release to release the variable. If one or two variables are selected, a chart
of the values is shown. Also resize and zoom is possible to see more details. The chart will be updated every 250
milliseconds:

acontis technologies GmbH AT3219 Page 35/81



User Manual

It is also possible to add the variables to a watch list (next chapter).

5.2.3 Watch list

In this tab, the user can monitor selected variables. He can go through the SubDevices and add variables to the watch
list to monitor them. The user can also export or import the watch list, so changes can be saved:
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5.2.4 Performance

In this tab, the user can see the busload per cycle and per second:

5.2.5 Data Acquisition Diagnosis

In this tab, the user can start and stop the DAQ recorders. Also he can see some statistics of running
recorders.
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5.3 SubDevice

This section shows the current “health” state of the selected SubDevice and helps the user to analyze SubDevice
related problems.

5.3.1 General (SubDevice)

In this tab, the user can see the current state of the state machine of the SubDevice:

State Machine

Current State:
Current state of the selected SubDevice

Requested State:
Requested state of the selected SubDevice

Software Diagnostics

State Machine Error:
SubDevice error which occurred during state transition

Hardware Diagnostics

Summary:
Summary of hardware diagnostics

Port A:
Port specific error

Port D:
Port specific error
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Port B:
Port specific error

Port C:
Port specific error

Buttons

Acknowledge:
Acknowledge the current error state and notify the user again if error state was changed again.

Possible warning and errors:

Disturbed Connection:
There may be problems in the connection between two SubDevices. The message will tell either that
there is a problem between two SubDevices or two ports. The warning appears if error counters are
increased (Invalid Frame: 0x300-0x306, RXErrors: 0x301-0x307, Lost Link: 0x308-0x30B). The value
from which a warning is issued can be set in the User.xml files in C:/ProgramData/EC-Engineer. More
information below.

Bad Connection:
The same as “Disturbed Connection” but the error counters are higher. The value from which an error is
issued can be set in the User.xml files in C:/ProgramData/EC-Engineer. More information below.

Line break:
A line break is detected before a SubDevice. This error is detected by looking at the topology.

Link missing:
A link is missing on input port of the SubDevice. This error is detected by looking at the topology.

Multiple warnings:
There are multiple warning for this port.

Multiple errors:
There are multiple errors for this port.

Multiple warnings and errors:
There are multiple warning and errors for this port.

State Machine:
See ETG1020 “Description of AL Status Codes” or ETG.1000.6. This error is detected by looking at
the AL Status (0x130).

How to solve errors?

• Lost Link errors are often caused by the power supply system
• Helpful might be the usage of an extra power supply
• It is recommended to clear all error counters after startup

How to change amount of errors leading to a warning or error:

• Open C:/ProgramData/EC-Inspector
• Search for DiagGeneral
• Change the values which should be adjusted

– LostLink: The value entered is used
– All others are calculated depending on the amount of cyclic frames: (Value / CyclicFrames) x
10^6
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Note: Please refer also the “ETG.1600 EtherCAT Installation Guideline”: http://www.ethercat.org/ETG1600.

5.3.2 Variables

In this tab, the user can see and change the values of the process variables. The variables will be forced to the value
the user entered. The user can press release to release the variable. If one or two variables are selected, a chart
of the values is shown. Also resize and zoom is possible to see more details. The chart will be updated every 250
milliseconds:

5.3.3 ESC Register

In this tab, the user can see the values of the registers. In the settings section he can set the offset and the length. If
he activates the compact view, he will only see the registers which have a description:
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5.3.4 Extended Diagnosis

In this tab, the user can see the extended diagnosis information:

There will be a red ! to signalize that a counter is higher than 0. Except for the forwarded errors.
If an error counter is ‘-’ it was not read. If it is ‘0’ it is really zero. So there is a difference between ‘0’ and ‘-‘.
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Common Error Counter

Processing Error Counter:
Indicates that SubDevice received “not EtherCAT frames”, which are not allowed in the EtherCAT seg-
ment (of course acceptable in a test environment)

PDI Error Counter:
Counts if a PDI access has an interface error (read from register: 0x30D)

Port 0..3

• Invalid Frame Counter of Port y (read from register: 0x0300+y*2)
• RX Error Counter of Port y (read from register: 0x0300+y*2+8Bit)
• Lost Link Counter of Port y (read from register: 0x0310+y)
• Forwarded RX Error Counter of Port y (read from register: 0x0308+y)

Acknowledge warning
If one of the error counters increase there will be a warning in the tree, sigalized with an icon. With this button
it is possible to acknowledge this warning. So the SubDevice can be monitored again and the icon will come
back with the next error.

To see this information the error counters must be read by the EtherCAT MainDevice. Only if this is activated the
EC-Inspector is able to read this. Here is a quick overview on how to activate this function on different MainDevices:
acontis EC-Master:

To activate the error collection of the acontis EC-Master, the follwing API has to be called:

/* SubDevice statistics polling for error diagnostic */
EC_T_DWORD dwPeriodMs = 1000;
dwRes = ecatIoCtl(EC_IOCTL_SET_SLVSTAT_PERIOD, (EC_T_BYTE*)&dwPeriodMs,
sizeof(EC_T_DWORD), EC_NULL, 0, EC_NULL);
if (dwRes != EC_E_NOERROR)
{

EcLogMsg(EC_LOG_LEVEL_ERROR, (pEcLogContext, EC_LOG_LEVEL_ERROR,
"ecatIoControl(EC_IOCTL_SET_SLVSTAT_PERIOD) returns with error=0x%x\n", dwRes));

goto Exit;
}

Third Party MainDevice:
Find more details here Operating with Third Party EtherCAT Controller

5.3.5 CoE Object-Dictionary

This tab consists of different modes:
Description from ESI

In this tab, the user can see the description of the object dictionary from ESI and the values from the SubDe-
vice.
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Lists of CoE Object-Dictionary entries

• Entries comes from ESI

• The “Flags” column tells the user if this entry is an PDO entry and if it can be edited

– “AA BB C D (EE FF GG)”
– AA = Mapping as RX PDO or not
– BB = Mapping as TX PDO or not
– C = Backup Flag
– D = Settings Flag
– EE = Access rights for PreOp (RO, WO, RW)
– FF = Access rights for SafeOp (RO, WO, RW)
– GG = Access rights for Op (RO, WO, RW)

Single Object
In this tab, the user can read and write (not EC-Inspector) the values of the object dictionary of the SubDevice.
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Settings

Index:
Index of the CoE value

SubIndex:
SubIndex of the CoE value

Size:
Size of the CoE value (only used for reading)

Complete Access:
Activate, if complete access mode should be used for reading or writing the CoE value (can be used only
if it is supported from SubDevice)

Operation

Read:
Reads the value from SubDevice (Hex format, like: “00 11 22 33 …”)

acontis technologies GmbH AT3219 Page 44/81



User Manual

5.3.6 File over Ethernet (FoE)

In this tab, the user has the possibility to download or upload a file to the SubDevice:

FoE Operations

Local Filename:
Name of the file on the harddrive

SubDevice Filename:
Name of the file on the SubDevice

Password:
Password on the SubDevice as a hex-number

Timeout:
Timeout for downloading or uploading the file in milliseconds

Max File Size:
Maximal file size which should be uploaded from the SubDevice in kilo bytes

5.3.7 History (SubDevice)

In this tab, the user can see and change the diagnosis history of the SubDevice. It is also possible to export
the data:
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Settings

Show Info Messages:
Info messages will be collected from SubDevice

Show Warning Messages:
Warning messages will be collected from SubDevice

Show Error Messages:
Error messages will be collected from SubDevice

Show Emergency Messages:
Emergency messages will be collected from SubDevice

Current Mode:
Overwrite Mode: Messages will be overwritten if buffer is full Acknowledge Mode: Messages will be
discarded if buffer is full

Messages
List of history messages

Change Message Handling

Enable/Disable Info Messages:
Enable or disable info messages

Enable/Disable Warning Messages:
Enable or disable warning messages

Enable/Disable Info Messages:
Enable or disable info messages

Enable/Disable Error Messages:
Enable or disable error messages

Enable/Disable Emergency Messages:
Enable or disable emergency messages

acontis technologies GmbH AT3219 Page 46/81



User Manual

Enable Acknowledge Mode:
Enable acknowledge mode

Enable Overwrite Mode:
Enable overwrite mode

Clear All Messages:
Clear all messages (only available if “Overwrite Mode” is active)

Clear All Acknowledged Messages:
Clear all acknowledged messages (only available if “Acknowledge Mode” is active)

Acknowledge All Messages:
Acknowledge all messages, that they can be overwritten from new messages (only available if “Acknowl-
edge Mode” is active)

5.3.8 Motion (Motion Tabs only)

In this tab, the user can see and change the motion settings of the SubDevice. He can read important
variables and change velocity and direction of the axis. Also gearing and camming are possible to use:
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6 Operating with Third Party EtherCAT Controller

6.1 Beckhoff TwinCAT

This section shows how to operate with Beckhoff TwinCAT.

6.1.1 TwinCAT ENI

In the EtherCAT tab in TwinCAT is a button “Export Configuration File…”. The “Export Configuration File…”
button opens a “Save as” dialog for saving the XML MainDevice configuration file. This file describes the process
data and the transfer frames that are sent during the EtherCAT state transitions. This is the ENI file, that can be used
with EC-Inspector.

6.1.2 Activate TwinCAT Error Counters

At the EtherCAT MainDevice, select Properties and then select all hardware counters that you would like to
monitor.

6.2 Codesys

This section shows how to operate with Codesys. Codesys is supported from version 3.5.17. and higher.
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6.2.1 Codesys ENI

Command ‘Generate EtherCATXML’. The command is not integrated in the standard main menu. You can add it via
the dialog box Tools, Customize from the category Devices. This command opens the standard dialog box for saving
a file in the local file system. You can define a name and a storage location for an xml file, in which CODESYS is to
store the EtherCAT configuration of the EtherCAT MainDevice currently selected in the device tree. Call: Context
menu of an EtherCAT MainDevice device object in the device tree.

6.2.2 Activate Codesys Error Counters

The error registers are not read cyclically. With the function block readmemory from the EtherCAT Library this can
be realized within the application.
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7 Additional Tools

7.1 ESI-Manager

ESI-Manager can be found through the main menu File -> ESI-Manager.
This dialog helps the user to administrate his ESI and SCI files. Here, he can add/delete/export ESI and

SCI files.
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7.2 Inspection Report

If you want to print or show a report about the actual session, it is possible with the inspection report. I
shows a lot of different data about the network communication. It is also possible to print a PDF.

7.3 Settings

Can be found inside the settings menu bar.
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7.3.1 General

Appearance

Language:
Changes the current language

Theme:
Changes the current theme
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7.3.2 Message Level

In this tab the log level of the message panel can be changed.
Log Level Settings

Message Level:
Changes what messages are displayed on the message panel

Explanation
We can see what messages are displayed depending on the selected message level (true it is displayed, false it
is not displayed)
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7.3.3 Capture File

A capture file could be helpful, if a very large system is given or the system is not always available. In that case the
user can connect to their system, save one or more snapshots into a capture file and analyse the created capture file
later.
Another use case is, that their system from time to time some problems. In that case the user can activate the automatic
mode and create the snapshots at specific intervals or based on specific MainDevice notifications.
At the moment there are the following options:

Filename

Folder:
Path, where the capture files should be saved

Base file name:
Base file name of the generated capture file name

Date:
Activate, to add the date to the generated capture file name
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Time:
Activate, to add the time to the generated capture file name

IP Address:
Activate, to add the IP address to the generated capture file name

Preview:
Shows a preview of the generated capture file name

Content

Process data:
Activate to add process data to the capture file (read-only)

EEPROM size:
Enter size of the EEPROM (0x86 = default, 0 = no EEPROM)

ESC Register size:
Enter size of the ESC Registers (0x400 = default, 0 = no ESC register)

CoE OD of SubDevices:

Select the SubDevices of which the CoE OD information will be captured

None:
CoE OD will be not captured

All:
CoE OD will be captured of all SubDevices

User defined:
CoEODwill be captured of the defined SubDevices by physical address (e.g. 1001-1003; 1005)

CoE OD objects:
Enter index of specific objects or all objects will be collected (e.g. 0x1018; 0x7000-0x7FFF)

SDO Info Service:
Activate to use the SDO Info Service for loading the CoE Object Dictionary instead of readying the
information from the ESI file.

Automatic Mode

Interval (min):
Time to wait until next snapshot will be taken

Maximum Snapshots:
Enter count of maximum snapshots

Notifications:

Select the notifications, which will trigger a snapshot. The following notifications are availabe
(for more information about notifications please refer the manual of EC-Master):

• STATECHANGED
• ETH_LINK_CONNECTED
• ETH_LINK_NOT_CONNECTED
• SLAVE_STATECHANGED
• SLAVE_PRESENCE
• SLAVE_INITCMD_RESPONSE_ERROR
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• STATUS_SLAVE_ERROR
• SLAVE_UNEXPECTED_STATE
• DC_SLV_SYNC
• DCM_SYNC

After the snapshot(s) is / are made in diagnosis mode they can be selected in the overview in config mode:

After the selection switching to diagnosis mode is possible. In the toolbar will be an additional combobox to
select the snapshot and switch between them:
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7.3.4 Pcap File

With EC-Inspector it is possible to capture a pcap file, same as Wireshark. Open Settings/Pcap File and
the follwing dialog appears:

Filename

Folder:
Path, where the pcap files should be saved

Base file name:
Base file name of the generated pcap file name

Date:
Activate, to add the date to the generated pcap file name

Time:
Activate, to add the time to the generated pcap file name

Output format:
The output format can be selected. Pcap or pcapng
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Create a new file automatically:
A new file is created after one of the multiple file switch conditions is met. They will be named:
name.00000.pcap. With the ringbuffer option a file is created if value is not reached, otherwise it will
replace the oldest of the formerly used files (thus forming a “ring”). This mode will limit the maximum
disk usage, even for an unlimited amount of capture input data, only keeping the latest captured data.

On the toolbar will be a new button in diagnosis mode to start and stop the pcap file recorder:

It is also possible to record a pcap backtrace file. When EC-Inspector is in pause mode (e.g. from a trigger condition)
the user can capture the last 64 frames via the backtrace button in the toolbar.
After the capture is made in diagnosis mode it can be selected in the overview in config mode as described in the
previous chapterWireshark File.

7.3.5 FoE File

With EC-Inspector it is possible to capture a file which is transferred via FoE. Open Settings/FoE File and
the follwing dialog appears:
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Filename

Folder:
Path, where the FoE files should be saved

Wireshark File

With the EC-Inspector it is possible to analyze a previous recorded catupre file pcap or pcapng.
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Therefore a wireshark have to be captured and saved as pcap or pcapng. Then it can be selected in the starting view
of the EC-Inspector. Also the ENI file has to be selected.

It is also possible to read multiple files. Therefore the pcap files have to named like that: name.00000.pcap.
On switching to diagnosis mode the file will be read by EC-Monitor. After that the file is in play mode. It is possible
to play the file faster or slower or select pause. There is also a function to execute a specified amount of cycles. This
can all be done in the toolbar:
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7.3.6 Settings File

Inside this file the user can modify all settings, including some that are not present in the settings dialog.

Warning: Only modify this file if you know what you are doing.
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The file can be located either at “C:/ProgramData/EC-Engineer/User.<username>.xml” or insdie the install di-
rectory.
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8 Customization

8.1 Multi-Language-Support

EC-Inspector supports multiple languages, which can be changed at runtime. Adding support for further lanuages is
quite easy because it is just a simple XML file which must be added to the kit.
All language files are stored in: “%ProgramFiles%/acontis_technologies/EC-Inspector/Languages/…`
EC-Inspector has also full UNICODE support, which means that it is also possible to support Asian languages:

8.2 Themes

EC-Inspector supports multiple themes, which can be changed during compile time. Adding support for further
themes is quite easy because a theme consists of a couple of XAML files which must be added to the kit.
Five themes are already included into EC-Inspector:
Royal Light Theme

acontis technologies GmbH AT3219 Page 63/81



User Manual

IG Theme

Luna Theme
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Office 2010 Blue Theme

Office 2013 Theme
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9 Licensing

9.1 Third party Software

EC-Inspector is using the following third party software:
• Infragistics

9.2 EC-Inspector License

For EC-Inspector we have two license models:
• Node Locked License
• Floating License

9.3 Node Locked License

If you choose this license model, you need an USB dongle for every single computer. This dongle must be plugged
into the computer where you want to use EC-Inspector.

9.4 Floating License

If you choose this license model, you need only one USB dongle with multiple floating licenses. This dongle must be
plugged into your license server and all client computers will connect to this license server.
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Note: This requires that the “WebAdmin” of the “Code Meter” is installed on the system. Please download and
install the “Code Meter Runtime” from WIBU: https://www.wibu.com/

9.4.1 Configure License Server

Install the “Dongle-Version” of EC-Inspector on your license server, plug-in your USB dongle and open the
“WebAdmin”:

In the “WebAdmin” navigate to “Configuration Server”, select the option “Run Network Server” and press
Apply:
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9.4.2 Configure Client Computer

Install the “Dongle-Version” of EC-Inspector and open the “WebAdmin”:

In the “WebAdmin” navigate to “Configuration Network”, press add, enter your IP address of your license
server and press Apply:
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Now, you should be able to start EC-Inspector.

Note: If too many clients are connected you will, you will receive the following error message:

In that case, you should try to close unused EC-Inspector instances or buy more floating licenses.
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9.5 License Update

9.5.1 Request License Update

Step 1: Install the “Dongle-Version” of EC-Inspector and open the “CodeMeter Control Center”:

If the selected license is a virtual dongle, simply drag and drop the WibuCmLIF file onto the CodeMeter Control
Center. Otherwise, the dongle should already be visible.
Step 2: In the “CodeMeter Control Center” open the “CmFAS Assistent” by clicking on License Update:

Step 3: Now, follow the assistant until you can select a file name:
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Step 4: Select “Create license request”:

Step 5: Select “Extend existing license”:
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Step 6: Keep the selected the vendor:

Step 7: Select the file name:
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Step 8: Finish the assistant:

Step 9: Your license request file *.WibuCmRaC has been successfully created. Please send it to sales@acontis.com
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9.5.2 Install License Update

After you have been sent your license request file you will receive the license update file *.WibuCmRaU.
Step 1: Connect your dongle.
Step 2: Copy the license update file to your desktop.
Step 3: Double-click on the license update file:

9.6 Dongle Firmware Update

Step 1: Install the “Dongle-Version” of EC-Inspector and open the “CodeMeter Control Center”:

Step 2: In the “CodeMeter Control Center” click on Update Firmware of selected Cm Dongle:
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Step 3: Execute firmware update by pressing OK:

Step 4: Wait until firmware update was executed:
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Step 5: Firmware update was done and dongle can be removed:

9.7 Expiration Date Dongle

If you chosed a expiration dongle you can find your expiration date in the ‘About Dialog’. If you have an
unlimited dongle you will not see a date in the dialog.
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If you see this date you can not use an Engineer which was released after the expiration date, but all older ones are
possible.
If you try to start an Engineer which is newer than the expiration date, you will get the following error:
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10 FAQ, Tips

10.1 Help in case of a problem

If you have a problem with EC-Inspector or something does not run as expected, please try first the following things:
• Read messages in message window
• Increase message level Menu ‣ Settings ‣ All Messages
• Read log file for more information Menu ‣ Help ‣ Show ‣ Log ‣File

• Restart EC-Inspector and try to do it again
• Contact support by sending a mail to ecsupport@acontis.com and attach the following information

– Project file .ecc or .eci if available
– EC-Inspector Version Menu ‣ Help ‣ About
– Log file Menu ‣ Help ‣ Show Log File

– Short description how the reproduce it

10.2 Internal User Specific Settings

EC-Inspector saves all user specific settings in a subfolder of the all users directoy %ALLUSERSPROFILE%/EC-
Inspector like C:/ProgramData/EC-Inspector.
In this directoy there is a XML file called User.myusername.xml. In this file, the user can find additional settings,
which can be helpful for solving some problems:
MasterUnitLocalCycleTime = 1

Bus cycle time of the internal MainDevice in milliseconds
MasterUnitLocalWorkerSleepTimeMs = 100

Cycle time of the local MainDevice thread in milliseconds
MasterUnitRemoteWorkerSleepTimeMs = 300

Cycle time of the remote MainDevice thread in milliseconds
MasterUnitTimerNormalCount = 4

• Time shift to cycle time of the normal refresh cycle
• E.g. local MainDevice = 100 ms, normal refresh cycle is every 400 ms
• Used e.g. for updating MainDevice information, error counters of SubDevice, …

MasterUnitTimerSlowerCount = 20

• Time shift to cycle time of the slower refresh cycle
• E.g. local MainDevice = 100 ms, slower refresh cycle is every 2 seconds
• Used e.g. for updating the SubDevice information, EEPROM data, register data, …

MasterUnitTimerSlowestCount = 120

• Time shift to cycle time of the slowest refresh cycle
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• E.g. local MainDevice = 100 ms, slower refresh cycle is every 12 seconds
• Used e.g. for updating the CoE Object Dictionary, …

MasterUnitScanBusTimeout = 5000
Timeot for bus scan in milliseconds

MasterUnitMailboxTimeout = 5000
Timeout for mailbox access in milliseconds

MasterUnitStateChangeTimeout = 5000
Timeout for changing state machines in milliseconds

MasterUnitRegisterTimeout = 3000
Timeout for register access in milliseconds

MasterUnitProcessDataTimeout = 1000
Timeout for process data access in milliseconds

MasterUnitEepromTimeout = 3000
Timeout for EEPROM access in milliseconds

MasterUnitRasCycleTime = 0
Internal RAS cycle time for polling

MasterUnitRasWatchDog = 0
Internal RAS watchdog interval

MasterUnitRasWdToLimit = 0
Internal RAS watchdog limit

DiagGeneralErrorLvlLostLink = 10
Theshold value for the “Lost Link Errors”, which leads to an error

DiagGeneralWarningLvlLostLink = 1
Theshold value of the “Lost Link Errors”, which leads to a warning

DiagGeneralErrLvlRxError = 10
Theshold value for the “RX Errors”, which leads to an error

DiagGeneralWarnLvlRxError = 0.001
Theshold value of the “RX Errors”, which leads to a warning

DiagGeneralErrLvlInvalidFrame = 10
Theshold value for the “Invalid Frames”, which leads to an error

DiagGeneralWarnLvlInvalidFrame = 0.001
Theshold value of the “Invalid Frames”, which leads to a warning

DiagGeneralErrLvlProcUnitErr = 1000
Theshold value for the “Processing Unit Errors”, which leads to an error

DiagGeneralWarnLvlProcUnitErr = 100
Theshold value of the “Processing Unit Errors”, which leads to a warning

MasterDebugMessageLevel = 0
Activates extended debug messages of the EC-Master (0 = Silent, 1 = Any, 2 = Critical, 3 = Error, 4 =Warning,
5 = Info, 6 = InfoApi, 7 = Verbose, 8 = VerboseCyc)

GuiDebugMessageLevel = 0
Activates extended debug messages of the GUI (0 = Off, 1 = Errors, 2 = All)

IndentXmlFiles = False
Activates indenting of XML files (makes exported XML files readable, but increases size)

EnhancedUtf8Support = False
Activates the enhanced UTF-8 support, which might be necessary if characters will be not displayed correctly
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10.3 FAQ

Solutions for possible problems:
• The integrated Device does not react as estimated

Increase the message level (Menu Settings All Messages) and try it again.
• EC-Inspector reports a message with ErrCode: 0x…

Error Codes comes directly from theDevice. If you want to knowwhat to know how to solve this problem,
please refer the manual of EC-Master / EC-Monitor.

• Permanent frame loss while monitoring TwinCAT
Please try with Npcap instead of NDIS driver

• WebAdmin in Dongle-Version shows page not found, what can I do?
You have to download and install the Code Meter Runtime from WIBU https://www.wibu.com/

• UTF8 characters e.g. in variables or PDOs will be not displayed correctly
This requires the enhanced UTF-8 support and can be enabled by setting “EnhancedUtf8Support = True”,
(see Internal User Specific Settings)
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